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About this Database 

This database contains the full complement of more than 300 site sheets (text descriptions) 
describing all of the international biosphere reserves currently in existence. Also included 
are supporting materials, graphics, and maps showing the general location of the reserves. 
It was developed primarily for the M A B national committees and people working on 
biosphere reserves. It should also be of value to research institutions, students, and 
others. This database is a first attempt to provide information about biosphere reserves in 
an electronic format to a wide user audience. Therefore comments, suggestions, and 
corrections are especially appropriate. 

Additional Information 

For queries, suggestions and further information, please contact: 

Division of Ecological Sciences or Protected Areas Data Unit 
Programme on M a n and the Biosphere ( M A B ) World Conservation Monitoring Centre 
1, rue Miollis 219 Huntingdon Road 
75015 P A R I S Cambridge C B 3 O D L 
France United Kingdom 
Tel: +33.1 45684142 Tel: + 4 4 223 277314 
Fax: +33.1 40659897 Fax: + 4 4 223 277136 

E-Mail: donaldg@wcmc.org.uk 

A n y suggestions on h o w to improve this Folio infobase are most welcome. 

About Folio Views 

The database was created with Folio Views software, a run-time version of which is 
included with each copy of the database. It provides for very rapid retrieval of one or 
more site sheets based on any word(s) in the sheet. This run-time version does not allow 
the user to reorganize or update the database. Databases created by and using the Folio 
Views software are called infobases. The terms infobase and database are used 
interchangeably in this documentation and in the help and manual files that are part of the 
program. 

Folio Views is a product of the Folio Corporation, 2155 North Freedom Boulevard, 
Provo, Utah 84604, United States; Tel: + 1 801 344 3700. Folio Views is available for 
D O S , Windows and the Macintosh. The graphics viewer, V C G M . E X E , is freeware 
written by Robert M . Crawford. 
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Introduction 

T h e M a n and the Biosphere ( M A B ) Programme, launched in 1971, is a global programme 
of international scientific cooperation dealing with people-environment interactions over 
the entire realm of bioclimatic and geographic situations of the biosphere from polar to 
tropical zones, from islands and coastal areas to high mountain regions, and from sparsely 
populated regions to dense h u m a n settlements. Research under the M A B Programme is 
designed to solve practical problems of resource management, and aims to fill significant 
gaps in the understanding of the structure and function of ecosystems, and of the impact 
of different types of human interaction. Key ingredients in the M A B Programme are the 
involvement of decision-makers and local people in research projects, training and 
demonstration at the field level, and the bringing together of disciplines from the social, 
biological and physical sciences in addressing complex environmental problems. 

A key component of the M A B Programme is the establishment of a global network of 
biosphere reserves. These reserves play three basic roles: 

Conservation Biosphere reserves provide protection of indigenous genetic 
resources, plant and animal species, ecosystems, and landscapes of value for the 
conservation of the world's biological diversity; 

Development Biosphere reserves are established to promote the goals of 
conservation and sustainable use of ecosystem resources. These goals are achieved 
through close cooperation with local communities, taking advantage of traditional 
knowledge, indigenous products and appropriate land management; 

Logistic Biosphere reserves are linked through a global network; they provide 
facilities for research, monitoring, education and training for local purposes as 
well as for regional or international initiatives. 

In order to fulfil their conservation, development, and logistic roles, biosphere reserves 
are typically comprised of three distinct zones. The core area (or areas) are devoted to 
strict protection in accordance with pre-established conservation objectives. The core area 
is surrounded, or is contiguous with, a delineated buffer zone (or zones) where the only 
activities permitted are those which are compatible with identified conservation objectives. 
T h e buffer zone, in turn, is surrounded by a transition area where co-operation with local 
populations and sustainable resource management practices is developed. 

A s of October 1993, there were a total of 311 biosphere reserves, covering a total area of 
around 176.6 million hectares (ha) in over 80 countries. These sites range in size from 
those such as Pare national du Tassili, Algeria, covering 7.2 million ha, to the 
Waddensea of H a m b u r g , Germany, with an approved area of ll,700ha. M a n y biosphere 
reserves include a number of nationally-designated conservation units, ranging from 
national parks to indigenous reserves. 
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Following the inception of the M A B Programme in the early 1970s, two main trends have 
emerged in the global biosphere reserve network: (1) it is a network that is expanding, 
both in terms of total number of sites and countries with approved biosphere reserves; and 
(2), it is a network that is constantly evolving to meet the dual needs of conservation and 
sustainable development for local communities. It is the latter, especially, which is the 
key distinguishing feature of biosphere reserves. 

Information M a n a g e m e n t 

In order to summarise information about individual biosphere reserves, the World 
Conservation Monitoring Centre ( W C M C ) , in consultation with the Division of Ecological 
Sciences, U N E S C O , has prepared text descriptions (site sheets), based on a standardised 
format. This format and its presentation has been developed to yield concise, 
comprehensive information about biosphere reserves in the context of their basic roles. 

The text descriptions follow a standardised format to allow comparison between sites in 
the global network of biosphere reserves. Information in each site description includes 
materials on major ecological features; descriptions of research, conservation and 
monitoring initiatives; local h u m a n activities and interaction in and around biosphere 
reserves; and management issues associated with such sites. Over the years, this 
"format" has changed in response to the types of information U N E S C O , M A B national 
committees and the user community have desired, and continues to evolve in response to 
this demand. 

W C M C first worked with U N E S C O on a compilation of biosphere reserve lists and 
analyses in 1983, for the First International Biosphere Reserve Congress, Minsk, 
Byelorussia. Subsequently, W C M C , the World Conservation Union ( I U C N ) and 
U N E S C O have worked together on the preparation of directories of biosphere reserves, 
published in 1986 and 1990. In 1992, W C M C presented the M A B Secretariat with text 
descriptions for all biosphere reserves in Folio Views. This database for broader 
distribution is built on that first attempt. W C M C has also worked with the U N E S C O 
Secretariat in the preparation of publications and discussion papers on information 
management, and in revising the nomination form for biosphere reserves. 

Besides the database of text descriptions that exists for all sites, a series of other 
databases for biosphere reserves are currently being planned by the U N E S C O Secretariat, 
in collaboration with W C M C . These include databases on species, habitats and 
ecosystems covered by biosphere reserves; on-going research and development projects; 
bibliography of research reports and publications; directory of scientists and institutions; 
digital (Geographic Information System) atlas of biosphere reserves; and a database of 
biosphere reserve background documents. 

T h e presentation of biosphere reserve information in "hard-copy" format is enhanced 
through the use of text-retrieval systems. Consequently, the Folio Views infobase that is 
subsequently described has been chosen to enable a relatively straight-forward search and 
retrieval of relevant materials. This is particularly useful given the volume of information 
on biosphere reserves in the form of text descriptions, graphics and maps . 
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Installation 

Quick Start 

1. T o install the program insert disk 1 in drive, and type A:load. Follow the 
instructions on the screen. 

2 . T o run the program type biores. 

3. Extensive on-line help and tutorials are available by pressing Fl. 

System Requirements 

In order for you to install and use this text database (infobase) successfully, your system 
should contain: 

1. A n I B M P C / X T or compatible. Faster processors, 80386 or 80486, will provide 
better performance, but the infobase will run successfully on an I B M P C / X T . 

2 . M S - D O S 3.1 or higher. 

3. A minimum of 512 kilobytes of Random Access Memory ( R A M ) . 

4 . A 3.5" high density floppy disk drive. 

5. A hard disk drive with at least 6 megabytes of free space. 

6. A monitor capable of displaying graphics. The program will run on a text-only 
monitor, but you will not be able to view the maps and charts. 

7 . A mouse is recommended but not required. 

Installing on a Stand-alone Computer 

1. Insert the disk labelled Disk 1/3, Biosphere Reserves... into your floppy drive. 

2 . At the D O S prompt, type A:load and press Enter. If the floppy drive you are 
using is not A : , substitute the correct letter for the drive. 

Load displays an introductory screen 

3. Select Automatic from the menu and press Enter. 
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4. O n the next screen you will probably want to edit the Destination 
Drive/Directory. W e suggest that you create a separate directory, named \biores. 

5. If the directory does not already exist, you will be asked if you want to create it. 

6. The next screen will ask you to Insert Disk 1, which should already be in the 
drive. Press Enter. 

The loading process will begin, with the screen displaying the progress in 
installing the individual files. 

7. You will be prompted to Insert Disk 2 (and then Disk 3). 

8. W h e n done, the screen will display Load Completed. Pressing any key will 
return you to the D O S prompt. 

The load process should have installed the following files on your hard drive: 

B I O R E S . N F O The database itself including the complete text of all 
biosphere reserve site sheets plus all indexes 

* .CGM Graphics (maps and charts) 
B I O R E S . C O M & The searching and 

BIORES.EXE viewing programs 
R T M A N U A L . N F O The help file and manual 
V I E W S . P T R The printer definitions 
V C G M . E X E Computer Graphics Metafile (CGM) viewer program 
L O A D . E X E The installation program 

Starting the Database 

1. At the D O S prompt, type cd \biores and press Enter. (If you installed the 
program in another directory, type the name of the directory instead of biores). 

2. Type biores, then press Enter. 

Installing on a Network 

You m a y install the database on a local area network. The loading process is identical to 
that for a stand-alone computer. The following suggestions will help maintain the 
integrity of the database and provide users with access to it: 

1. The users need only 'read' privileges to the directory containing the database and 
program files. 
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2 . T o use a network printer, you should use a capture (or its equivalent) c o m m a n d to 
redirect output from one of your terminal ports to a network printer. 

3 . W h e n saving text to a file, you must have 'write' privileges for the directory to 
which the output will be sent. The default directory to which the files are saved is 
the directory in which the program was started. 

4 . A n y temporary files that the program creates will be placed in the temporary file 
path. Network users should be careful to specify a directory in which they have 
'write' privileges. If this field is empty, the program will place temporary files in 
the current directory. 

5. Set the Infobase search path pointing to the directory containing the database and 
program files as shown in Setting Defaults starting on page 10. Once the path to 
the infobase has been saved in a configuration file, V I E W S . C F G , you m a y start 
the database from directory containing the configuration file by typing [Infobase 
search path]\biores and pressing Enter. 
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Structure and Contents of Database 

The database is organised as follows: 

• Title Page (your first view of the database). 

• Table of Contents (with links to listed sections) 

• Introduction 

• Overview and S u m m a r y (including graphics) 

• List of Biosphere Reserves 

• Individual Site Sheets (grouped alphabetically by country) 

• This manual 

In addition there are links to maps and graphics stored as separate D O S files. 

The List of Biosphere Reserves contains links to the country groups. In the example 
below the inverted triangle • to the left of Canada is a link to all site sheets for Canada. 
The token to the right of Canada , **• Press < Enter > to view location m a p , is a link 
to a m a p showing the general location of the reserves. 

List of Biosphere Reserves 
Area(ha) Date 

• CANADA •+ Press <Enter> to view location map 
Long Point Biosphere Reserve 27,000 1986 
Mont St Hilaire 5,550 1978 
Niagara Escarpment Biosphere Reserve 207,240 1990 
Réserve de la biosphère de Charlevoix 460,000 1988 
Riding Mountain Biosphere Reserve 297,591 1986 
Waterton Lakes National Park 52,597 1979 
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Using the Biosphere Reserve Database 

Basic Concepts 

Familiarity with these terms will help you to use the infobase: 

Folio This is the basic unit of information. Here it is the site sheet for a single 
biosphere reserve. This is the same as a record in other databases. 

View One or more folios retrieved for viewing or printing. Y o u can have one or 
more views present in different windows at any one time. By default, one 
of the views will be the complete database. Subsets can be created by 
using the query tools. 

Reference The information used to identify a single folio. In this database it is a 
combination of the country and biosphere reserve names. For example 
C A N A D A - Riding Mountain Biosphere Reserve. 

Link A link between one part of the database and another related section. 
Examples are the links between the list of sites and groups of all sites in a 
country and those used to display the appropriate maps. Text links are 
displayed by an inverted triangle • , and links to maps or graphics are 
shown by a double-headed arrow **. 

Moving Around 

Y o u m a y use any feature by pressing keys on the keyboard or by using a mouse. It is a 
matter of personal preference and/or availability of a mouse. From the keyboard you can 
use the menus or keystroke combinations. 

Select pull down menus by holding down the Alt key and pressing the first letter of the 
menu item. For example Alt+F will display the File menu, Alt+S for the Search 
menu, and A l t + O for the Options menu. Once the menu is displayed, you can select 
options by pressing the highlighted letter or by using the cursor and Enter keys. 

Here are the basic keys. 

K e y Function 

Enter • Selects highlighted commands from menus 
• Opens a full view at the cursor 
• Follows links 

Esc • Discards the active window 
• Cancels a menu, command, or process 
• Cancels a search request 
• Caution! Exits program, if only a single window is on the screen. 
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Space • Accesses search windows 
• Performs a quick search (with text blocked) 

Tab/ • Moves the cursor to the next/prior link token 
Shift+Tab or the next/prior folio 

+ / - • Cycles between open windows 
(Numeric keypad) 

Ctrl+T • Toggles between full text and reference line display 

Ctrl+Z • Toggles between full screen and windowed display 

W h e n viewing the maps or charts, either the Esc, Enter, or Space bar keys will return 
you to the previous screen. 

Getting Help 

Besides this manual, extensive on-line help is available. 

Quick Help 

One line of quick, context-sensitive help will appear at the bottom of the screen, unless 
you have zoomed so that the text occupies the entire screen. This option can be switched 
on or off in the User Defaults screen under the Options menu. 

Using the Folio Manual Infobase to Get Help 

There are several ways to use this manual to get help. 

• For specific information about any menu command, highlight the command on the 
menu and press Fl . 

• For an alphabetical list of commands, press Fl, C . 
• For a list of tasks and instructions for accomplishing each task, press Fl, T . 
• For access to all sections of the user manual infobase, press Fl, M . You may 

then use the links to go to relevant section or search the manual just as you would 
search the Biosphere Reserve Database by pressing Space and entering the words 
you are looking for and then pressing Enter. 

T o exit Help, or any other command, press Esc. Depending on how many windows you 
have opened while in help you may have to press Esc several times. 

Caution! Pressing Esc when there is only one window open, i.e., no search, menu, or 
command in progress, will exit the program entirely. 

Page 6 U N E S C O M A B Biosphere Reserves Site Description Database 



Command Quick Reference 

This section contains an alphabetical list of commands with their corresponding 
keystrokes, and should be helpful as a quick reference guide. 

COMMAND 
File menu 
Help=Fl menu 
Options menu 
Search menu 

Block 
Exit 
G o to D O S 
Print... 
Save as... 
Switch application... 

Focus 
Highlight 
Infobase defaults... 
Markers 
Position/size window 
References 
Table viewer 
Text 
User defaults 
Z o o m window 

And 
Exclusive O r 
G o to folio/view... 
Group Membership 
Group name 
Not 
Or 
Place highlighted item 

in query 
Search infobase... 

MENU 
. . . 
. . . 
. . . 

. . . 

Füe 
File 
File 
File 
File 
File 

Options 
Options 
Options 
Options 
Options 
Options 
Options 
Options 
Options 
Options 

Search 
Search 
Search 
Search 
Search 
Search 
Search 

Search 
Search 

QUICK KEY 
Alt+F 
Fl 
Alt+O 
Alt+S 

Ctrl+B 
Shift+FIO 
Ctrl+Fl 
Ctrl+Print Screen 
Ctrl+S 
Ctrl+Shift+Fl 

Ctrl+F 
Ctrl+H 
Alt+O, I 
F9 
F8 
Ctrl+R 
Ctrl+V 
Ctrl+T 
Alt+O, U 
Ctrl+Z 

Ctrl+A 
Ctrl+E 
Ctrl+G 
Alt+S, M 
Ctrl+G 
Ctrl+N 
Ctrl+O 

Ctrl+Enter 
Space 
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Mouse Usage 

M o u s e usage is optional but fully supported. The mouse m a y be used for the following 
tasks: 

• Pulling down menus and selecting commands 
• Scrolling/navigating through text 
• Searching 

Search Screen Layout 

T o start a n e w search press Space. The database supports full boolean, proximity 
searches, and nesting. Searching is not case-sensitive. See Tutorial section for examples 
of each of these types of searches, or press Fl at this screen to view or search the 
manual. 

jftX* '•$«**«& o p t i o n n$Xp*WX 

WORDS 
concessioners 
concessions 
conch 
concinna 
concluded 
concolor 
concomitant 
concrete 
concretion 
concurrence 
concolor 

RESULTS 
felis 89-
concolor 37-1 

-&-31 

Tfelis concolor 

I— Enter=OK 

QUERY 

31 Matches Esc=Cancel —' 

Styl« «eai-ch vc«d/cirouí*(&í* presa Ç T R ^ + E N T E R to place fcicrtalfhfceá item ín't$t&;y 

In the above sample search for felis and concolor the number of hits is immediately 
displayed in the Results box as soon as the search word(s) have been entered. Note that 
the operator and is not included in the search. By default and is assumed to connect 
search words unless otherwise specified. The W o r d s box displays a complete list of all 
unique words in the database, and scrolls to the entry closest to the word currently being 
entered. Ctrl+Enter will place the highlighted word from this list into the query. 
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Text Screen Layout 

W h e n viewing the entire database or the results of queries, they will be presented in the 
following screen. This view m a y be toggled between a window view and a full screen 
view by pressing Ctrl+Z. 

The numbers in the upper right-hand corner are particularly significant as they show your 
location while viewing the results. 

jril* search option« •aeip«Ft 

r! lear Boar Total Folios in Current View—i 
y—Reference—j Active Folio^ I 

|&ÎÎAl&'&«&êserva: mondiale âe la biosphère de Charlevoix i/ZÏ 

CANADA - Quebec 

NAME Reserve mondiale de la biosphère de Charlevoix 

IUCN MANAGEMENT CATEGORY I (Scientific Reserve) 
IV (Managed Nature Reserve) 
V (Protected Landscape) 
IX (Biosphere Reserve) 

BIOGEOGRAPHICAL PROVINCE 1.04.03 (Canadian Taiga) 

GEOGRAPHICAL LOCATION The reserve is situated in Eastern Canada 
in the Laurentian massif. Its south-eastern border is the 
itijHESOQ m» Biosphere. Reserves : fells lynx 

t Database ïitle *- Current Search Words 
<—Window # 

ERTER to ope$ new view or follow link (TAB to T**)r +/» to cyele windows" 

Printer Installation 

1. Select Print from the File menu or press Ctrl+PrintScreen at the main screen. 
Select Install printer from the menu shown below by using the cursor keys and 
pressing Space to select the install option. [Note: O n this and other configuration 
screens the selected options are marked with a small dot • or an x.] 

Print 
• Install printer 
Terminate printing 

Enter=OK Esc=Cancel 
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2 . Then select the printer definition and port from the following screen. 

INSTALL PRINTER 

PRINTER 
Epson SQ-2000 
HP DeskJet* 
HP LaserJet 
HP LaserJetII 
HP LaserJetIIP 
UP MserJetïïI 
IBM Proprinter 
IBM Proprinter XL 

Enter=OK 

-Port 
• LPT1 
LPT2 
COMÍ 
COM2 

Esc=Cancel 

Setting Defaults 

T h e default settings that come with the program should be satisfactory for most users. 
However, for users with other preferences, or those running the database on a network, 
two screens, User Defaults and Infobase Defaults, allow the user to change these 
settings. The User Defaults screen affects the appearance (colours, positions and size of 
windows, menus, etc.) of the program. The Infobase Defaults screen contains choices 
about what information is displayed before and after searches and the colours or attributes 
used to indicate bold, underline, etc. text within windows. 

T o change either User or Infobase defaults select it from the Options m e n u . Use the tab 
key to move around the screen, and the cursor keys and space bar to select the desired 
options. If you want to change the default colours, an additional dialogue box will appear 
along with a window to allow you to view the results. Use the grey + / - keys on the 
numeric keypad to cycle through the available colours. Mouse users can simply point 
and click. 

Infobase Defaults 

Y o u will be presented with the following screen before seeing the main Infobase Defaults 
screen. The distinction between the two choices is only of significance to network users; 
the "set defaults in the infobase" option will affect all users initially. Individual users can 
then change them by choosing the "Set defaults in the configuration file" option. Single 
users will get the same results with either choice. 
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INFOBASE DEFAULTS 

Set defaults in the infobase 
• Set defaults in the configuration file 

Enter=OK Esc=Cancel 

See the Tutorial section beginning on page 15 for examples of how the "Text," 
"References," "Markers," and "Focus" choices affect the display of information. 

INFOBASE DEFAULTS (saved in config file) 

—Display Format-
xText 
-References 
-Markers 

i—Window Attributes 
Active Inactive 
• Color • Color 

B/W 

Mono 

B/W 

Mono 

—Display After Search-
-Text 
-References 
-Markers 
-Focus 
xNo modification 

—Focus 
3 Words before search term 

3 Words after search term 

- Save window position/size as top two infobase windows 

- Override infobase settings 

Save settings to: C:\TEMP 
Enter=OK 

\VIEWS.CFG 
Esc=Cancel 
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User Defaults 

In addition to the appearance options, the " T e m p file path;" is important to the proper 
functioning of the database. It should point to a disk with a minimum of lmb of free 
space. A n y temporary files that the program creates will be placed in the temporary file 
path. Network users should be careful to specify a directory in which they have 'write' 
privileges. If this field is empty, the database will place temporary files in the active 
directory. 

—Colors 
Backplane 

Menus 

Search 

Shadows 

Directory 

Dialog 

USER DEFAULTS 

—Backplane 

++ " inr 

Other 

—Search Windows 
-Store position/size 
xWords -Groups xResults 

Infobase search path:F:\TEST 

Temp file path:C:\TEMP\ 

Save settings to: C:\TEMP 

Enter=OK 

I—Display 
• Auto-detect 
Color 
B/W 

x Quick Help 

—Display Speed 
•Fast (may cause snow) 
Slow (no snow) 

\VIEWS.CFG 

Esc=Cancel 
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Tutorial 

Retrieving by Country 

There are two options when retrieving site sheets by country. 

1. In the List of Biosphere Reserves put the cursor on the link token • to the left of 
the country name and press Enter. Y o u will immediately select all site sheets for 
that country and the text window will display the top of the first site sheet. 

2 . Press the Space bar to begin a search. Then press Ctr l+G to select by group. 
The W o r d s section of the query screen will change to Groups and will contain a 
list of all countries. You may select a country by either typing in the country 
name and pressing Enter, or using the cursor keys to highlight the country name 
and pressing Ctrl+Enter. Either way the results will be identical to option 1. 

N O T E : The main use of groups in this database is to identify all site sheets in a 
given country. Y o u can specify a group in a search by use of the vertical bars 
| phrase | that can be entered either from the keyboard or by pressing Ctr l+G. 
Combine groups with other operators described below to construct more 
complicated queries. 

Retrieving by Reserve N a m e 

Again there are two options. 

1. T o retrieve site sheets by reserve name begin a search by pressing Space and then 
enter a double quotation mark " followed by words from the reserve name. The 
double quotation mark specifies an exact string search. This process will usually 
select both the individual site sheet and the List of Biosphere Reserves. The site 
sheet will be the second folio in the selected view. To m o v e rapidly to the second 
folio use the Ctr l+G or G o T o from the Search menu to get the G o T o dialogue 
box. Then under Folio # enter " 2 " and press Enter. For reserves with long 
names it will often not be necessary to enter the entire name. Enter words until 
the Results window shows that you have narrowed the search sufficiently. 

N O T E : Accented and other special foreign language characters are indexed as 
unique characters and must be entered in order to search for words that contain 
them. These may be entered by holding down the Alt key and typing in the 
decimal equivalent on the numeric keypad. A list of these characters is included 
under Foreign Language Characters at the end of this manual. 
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Retrieving by any Word in Text 

T o search for any word or words in the text simply press Space and enter the words. 
You may use a group of words in the text for a search by blocking them, then pressing 
Space. 

Wildcards 

In any search you m a y use the standard D O S ? and * wildcards. 

The ? wildcard will match any single character. For example, analys?s would match 
both analysis and analyses. 

The * wildcard will match any number of characters, including none. For example, 
analy* will match analyse, analyses, analysing, analysis, and analytic. 

Exact String Searches 

If you want to search for an exact string enclose the string with double quotation marks ". 
A good example would be "felis concolor" which will find all sheets that contain that 
exact string. 

Using 'And ' , 'Or', and 'Not' 

A N D : If more than one search word is entered, Folio Views assumes that both/all the 
words appear somewhere in the site sheet. Thus the entry felis concolor will find all site 
sheets that contain both felis A N D concolor somewhere in the sheet. The two words 
could be in entirely different sections of the site sheet. If you want, you can explicitly 
enter the ' & ' operator, but it is not necessary. You will see the ' & ' appear in the results 
window whether or not you enter it as a part of the query. 

O R (/): This operator requires that either of the words must appear somewhere in the 
site sheet. Enter the 'or' operator by pressing Ctr l+O or by simply typing a forward 
slash 7 ' between the words. A n 'or' query of France / Spain will find all sheets that 
contain either France O R Spain. A n important use of the 'or' operator is to specify a 
list of synonyms, i.e., lake* / river* / water will find sheets containing lake(s), river(s), 
or water. 

Exclusive O R (~): This is a variation of an 'or' query that requires that either word, 
but not both must be in the sheet. Enter the 'exclusive or' operator by pressing Ctrl+E 
or by typing a ' ~ ' . The sample query of desert ~ grassland will find all sheets that 
contain either desert O R grassland but not both desert A N D grassland. 
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N O T O : This operator provides for queries when you want all sheets containing the 
first word but not the second. Enter it by pressing Ctr l+N or by typing '"". The 
example felis A "felis concolor" will find all sheets containing felis but not felis concolor. 

Nesting 

In complicated searches, especially those using the 'or' operator, it is often important to 
specify the precedence of the various operators. Round brackets (parentheses) are used to 
specify which phrases are to be evaluated first. In this example, ¡ australia ¡ & (desert / 
grassland) will find all sheets in the australia group which contain either desert or 
grassland. Without nesting, the program will evaluate ¡australia! & desert / grassland 
as all sheets containing australia and desert plus any sheet containing just the word 
grassland. This m a y not be desired result. If in doubt use nesting as it never does any 
harm. 

Proximity Searches 

T o find two words, a specified number of words apart from each other, type the words 
beginning with double quotes ". Then type the @ character followed by a number 
showing the proximity in words that the two may be separated. For example the search 
"desert grasslands @ 3 will find all sheets where the word grasslands occurs within 3 
words of desert. 

Displaying Results of Search 

The top five choices on the Options (Alt+O) menu control what is displayed as the 
result of a search. The selected options will have a • in the left margin of the m e n u . 
Each choice can be toggled on or off. It is not possible to have no choices selected since 
this would imply that nothing would be displayed. 

The choices are: 

Text: W h e n selected, the full text of the site sheet will be displayed. 
References: References are the one-line identifiers that combine the country and site 
names. They can be displayed either alone or with other options. 
Markers: W h e n selected, a • will appear in the left margin of the display indicating the 
beginning of each folio (site sheet). 
Focus: W h e n selected, only the search terms plus the adjacent words will be displayed. 
Y o u can specify how many words will be displayed before and after the search word(s). 
This number is set in the Focus section of the Infobase Defaults screen found under the 
Options m e n u (see page 10). 
Highlight: W h e n selected, the search terms will be highlighted. 
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i? Options = = 
•Text 
References 
Markers 
Focus 
Highlight 

Zoom window 
Table Viewer 
Position/size 

User defaults. 
Infobase defai 

Ctrl+T 
Ctrl+R 

F9 
Ctrl+F 
Ctrl+H 

Ctrl+Z 
Ctrl+V 

windows F8 

tits 

Usually you will want to see the full text, which will appear like the Sample Site Sheet 
beginning on page 20 . Here are examples of other options. The results are from a 
search for felis concolor, but not in the United States. Twenty records are retrieved 
from the search. 

If you display only the references the display will be of the following form. 

CANADA-Waterton Lakes National Park 
ARGENTINA-Reserva Natural de Vida Silvestre Laguna Blanca 
ARGENTINA-Reserva de la Biosfera Laguna de Pozuelos 
ARGENTINA-Reserva de la Biosfera "San Guillermo" 
CHILE-Reserva de la Biosfera 'Araucarias' 
CHILE-Pargue Nacional Fray Jorge/Reserva Nacional Las Chinchillas 
CHILE-Laguna San Rafael National Park 
CHILE-Parque Nacional Torres del Paine 
COLOMBIA-Sierra Nevada de Santa Marta 
C0L0MBIA-E1 Tuparro Nature Reserve 
COSTA RICA-Reserva de la Biosfera de la Amistad 
COSTA RICA-Cordillera Volcánica Central 
ECUADOR-Yasuni National Park and Biosphere Reserve 
GUATEMALA-Reserva de la Biosfera Maya 
HONDURAS-Rio Plátano Biosphere Reserve 
MEXICO-Reserva de la Biosfera de Mapimi 
MEXICO-Reserva de la Biosfera La Michilia 
México-Reserva de la Biosfera de Sian Ka'an 
PERU-Reserva de Huascaran 
PERU-Reserva del Noroeste 

If you both display the Reference (Ctrl+R) and turn on Focus (Ctrl+F) then the display 
will also contain the search terms with the adjacent words in context as illustrated below. 

CANADA-Waterton Lakes National Park 
... latrans, cougar Felis concolor, grizzly bear Ursus ... 
ARGENTINA-Reserva Natural de Vida Silvestre Laguna Blanca 
... , mountain lion Felis concolor and Andean cat ... 
ARGENTINA-Reserva de la Biosfera Laguna de Pozuelos 
... and puma Felis concolor (Merino, 1987; Tecchi ... 
ARGENTINA-Reserva de la Biosfera "San Guillermo" 
... mountain lion Felis concolor. Birds include Andean ... 
CHILE-Reserva de la Biosfera 'Araucarias' 
... pudú, kodkod Felis guigna, puma F. concolor, guanaco Lama 
guanicoe... 
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Here is the same search but with the number of words increased (in Infobase Defaulte) 
to 10 both before and after. 

CANADA-Waterton Lakes National Park 
... Canis lupus (V) (very rare), coyote C. latrans, cougar Felis 
concolor, grizzly bear Ursus arctos horribilis, American black bear 
U. americanus... 
ARGENTINA-Reserva Natural de Vida Silvestre Laguna Blanca 
... including short-tailed chinchilla Chinchilla brevicaudata 
boliviana, mountain lion Felis concolor and Andean cat F. jacobita. 
Birds include lesser rhea Pterocnemia .. . 
ARGENTINA-Reserva de la Biosfera Laguna de Pozuelos 
... Lagidium viscaccia, leaf-eared mouse Phyllotis darwini and puma 
Felis concolor (Merino, 1987; Tecchi et al., 1989).... 
ARGENTINA-Reserva de la Biosfera "San Guillermo" 
... Lagidium viscacia and chinchilla Chinchilla brevicaudata, and 
mountain lion Felis concolor. Birds include Andean Condor Vultur 
gryphus, lesser rhea Pteroicnemia pennata... 

Viewing Maps and Charts 

T o view maps Tab to the link token that looks like **. The text here will indicate which 
m a p or chart will be displayed. Press Enter to display the m a p or chart. Press Esc, 
Return, or the Space bar to return to the infobase. You cannot print maps and charts 
from within the infobase. However, you may freely use the D O S computer graphics 
metafiles ( C G M ) which contain these graphics. They may be imported into many 
graphics and word processing programs. 

While viewing the graphic, use the grey + / - keys on the numeric keypad to zoom in and 
out. Use the cursor keys to view different sections if you have zoomed in. 

Printing 

Y o u print by selecting Print from the File menu , or by pressing Ctrl+PrintScreen. 
The following screen allows you to set what is included and the format of a print request. 
The choices illustrated starting on page 15 which are made from the Options menu affect 
both the display and the printed report. Thus if the screen shows only References, then 
only the references will be printed. 

The Scope choices (see illustration on next page) have the greatest impact on the printed 
output. Active folio will include only the current site sheet. Active view will include all 
site sheets selected by the current query, which would be all site sheets if no search had 
been started. However, you can choose to print only selected text with the Blocked text 
option. Block text by using Ctrl+B to mark the beginning, then use the cursor keys to 
highlight the text to be printed, then press Ctrl+PrintScreen. 
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1 PRINT 

i—Scope 
• Active 
Active 
Blocked 

folio 
view 
1 text 

—Include 
x Query 
x Highlight words 

I—Page Number Position—i 

I Spacing-
• Single 
Double 

Form Length 70 

• None 

Starting page # 1 

—Pr int er 
• Generic Printer (No Co (LPT1) 
HP LaserJetHI (LPT1) 

—Margins 
Top 0 

Left 0 Right 75 
Bottom 60 

- Redirect document to: C:\VIEWS\BIORES.PRN 

x Save settings to: C:\VIEWS 

Enter=OK 

\VIEWS.CFG 

Esc=Cancel 

For A 4 paper set page length to 70 lines. For 814 x 11 inch paper set page length to 66 
lines. 

The example below illustrates printing the result of the search used in the examples on 
preceding pages. The active folio is the site sheet for C A N A D A - Waterton Lakes 
National Park. Since w e have specified only the active folio, w e get only the Waterton 
Lakes data. If instead w e specified the active view, w e would get all 20 records 
retrieved by the search. The query line includes the database name plus the query used to 
select the specific sheets; in this case all sheets containing felis concolor but not in the 
United States of America country group. 

Query: UNESCO MAB Biosphere Reserves:(felis concolor*¡united states 
of america!) 

CANADA-Waterton Lakes National Park 
... Canis lupus (V) (very rare), coyote C. latrans, cougar Felis 
concolor, grizzly bear Ursus arctos horribilis, American black bear 
U. americanus... 

Saving Results to a File 

T o save the results to a file for use in other computer programs, chose Save A s from the 
File m e n u . The screen below illustrates the choices. The Generic W o r d Processing 
option produces a file with tabs and soft returns preserved. This form is easier to edit 
after importing into nearly all word processing programs. The D O S Text option 
produces a file much like a printed report with hard returns at the end of each line. 
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SAVE AS 

Filename: 

-Include-
- Query 

I—Scope 
• Active 
Active 

folio 
view 

Blocked text 

Format 
Generic Word Protœ$$iftû, 
Dos Text 

Enter=OK Esc=Cancel 
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Sample Site Sheet 

The main body of the database consists of 314 site sheets. Three biosphere reserves have 
two site sheets as they represent trans-frontier reserves. While there is some variation in 
the structure of the site sheets, they all contain the same basic information. Here is a 
sample site sheet for the Riding Mountain Biosphere Reserve in Canada. 

HAMS Riding Mountain Biosphere Reserve 

MANAGEMENT CATEGORY II and IX (National Park and Biosphere Reserve) 

BIOGEOGRAPHICAL PROVINCE 1.04.03 and 1.18.11 (Canadian Taiga and 
Grasslands) 

LEGAL PROTECTION Total 

DATE ESTABLISHED In 1895 an area of 247,000ha was set aside as a Forest 
Reserve and within it, in 1906, a game reserve was set up. The National 
Park was established in 1930 and the area accepted as a Biosphere Reserve 
in April 1986 

GEOGRAPHICAL LOCATION South central Canada, on the Manitoba escarpment, 
300km north-west of Winnipeg, 50°30'-51°01'N, 99°31,-101°05'W. 

ALTITUDE 318-755m 

AREA The Biosphere Reserve covers an area of 297,591ha 

LAND TENURE Government of Canada 

PHYSICAL FEATURES The park is situated in the Manitoba Escarpment region. 
This 300-350m high escarpment was part of the shoreline of the glacial Lake 
Agassiz and separates the Manitoba and Saskatchewan plains. Much of the 
park is a rolling plateau where the bedrock is covered with thick glacial 
deposits of sand, clay, gravel and boulders. Glacial features include 
kettle holes, meItwater channels, morainal ridges and incised gorges and 
there are many shallow lakes. The headwaters of 13 watersheds are 
contained in the park. The climate is cool summer humid continental, with 
mean January temperatures of -2°C and July temperatures of 16°C. Annual 
precipitation is about 480mm. 

VEGETATION The reserve is at the junction of three major ecosystems, 
grasslands and two components of the boreal forest biome, the aspen-oak and 
aspen-spruce ecosystems. Forests cover about 78% of the park and about 
two-thirds of their area is dominated by aspen Populus tremuloides. either 
in pure or mixed stands, reflecting earlier disturbance by logging and 
fires. Other trees in the coniferous ecosystem include white spruce Picea 
glauca, black spruce P. mariana, jack pine Pinus banksiana and balsam fir 
Abies balsamea. The aspen-oak ecosystem includes bur oak Quercus 
macrocarpa, Manitoba maple Acer nequndo, mountain maple A. spicatum. green 
ash Fraxinus pennsvlvanica, plum Prunus nigra, chokecherry P. virginiana 
and white elm Ulmus americana. Grasslands are dominated by rough fescue 
Festuca scabrella with porcupine grass Stipa spartea and dwarf sedges Carex 
spp.. Although grasslands occupy less than 1% of the reserve, they exist 
as discrete units and the climax rough fescue community represents the 
eastern extent of its range and its presence is of national importance due 
to the relative rarity of climax examples elsewhere. Over 400 species of 
vascular plant have been recorded in the park, 17 being rare in Manitoba. 

FAUNA The reserve is a near complete natural food web and is a refuge, 
surrounded by agricultural land. The beaver Castor canadensis, is 
abundant, and some interesting small rodents such as the water shrew Sorex 
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palustris, vagrant shrew S. vaqrans and northern lemming mouse Svnaptamus 
borealis. There are several carnivores, including the wolf Canis lupus. 
coyote C. latrans. black bear Ursus americanus and Canadian lynx Lvnx lvnx 
canadensis, and ungulates such as moose Alces alces, bison Bison bison, 
mule deer Odocoileus hemionus and white-tailed deer O. virqinianus. Two 
hundred and thirty-three species of birds have been recorded, among them 
the bald eagle Haliaeetus leucocephalus and osprey Pandion haliaetus which 
both nest in the park. The fish species found in the park include pike 
Esox lucius. lake whitefish Coreqonus clupeaformis, walleye Strizostedion 
vitreum vitreum, lake trout Cristivomer namavcush. rainbow trout Salmo 
oairdnerii and speckled trout Salvelinus fontinalis. The area is 
internationally known for its diversity of Lepidoptera, with 69 species of 
butterflies including 13 skippers recorded. 

CULTURAL HERITAGE Artifacts up to 4,000 years old have been found and 
indicate that native peoples visited the park to hunt and fish. Some fur 
traders exploited the area in the 18th century. 

CONSERVATION MANAGEMENT The area has been zoned to accommodate different 
land uses, and managed accordingly. Since 1980, additional baseline data 
has been collected and management objectives made more explicit. In 1980 
the Riding Mountain Regional Liaison Committee was formed which includes 
representatives from the surrounding 18 municipalities. 

ZONING This is in accordance with the National Parks Zoning System. 
Twelve core areas, or Special Preservation Zones, have been designated. 
Most of the reserve is a Wilderness Area. One site is set aside for 
Intensive Use and some sites have been set aside for roads and campsites. 
The surrounding Rural Municipalities are designated a Zone of Cooperation 
to act as an additional buffer. 

STAFF There are 105 full-time employees 

BUDGET US$6,522,00 for operation and maintenance in 1982-83 

LOCAL ADMINISTRATION Superintendent, Riding Mountain National Park, 
Wasagaming, Manitoba ROJ 2HO. 

VISITOR FACILITIES There are 657 campsites, 240 group tenting sites 158, 
trailer sites and some cottages; services and supplies or alternative 
accommodation are available in the town of Wasagaming. Power boating on 
some lakes and fishing are permitted and skiing is being developed. There 
are 32 trails which can be used on foot, cycle or horseback. In 1981-82 
there were 842,436 visitors. There is an interpretive centre and a variety 
of educational programmes are available. 

SCIENTIFIC RESEARCH AND FACILITIES There have been studies of the ecology 
of elk, moose, wolf, coyote, beaver and snowshoe hare and grassland 
ecology. Wilson Creek Watershed is a major long term research program and 
investigates possible remedies for headwater flooding. There is no special 
facilities, apart from a meteorological station. 

LOCAL POPULATION The surrounding area has a largely rural population but 
agricultural development is intensive. 

DISTURBANCES, DEFICIENCIES AND MANAGEMENT PROBLEMS A public highway 
traverses the eastern end of the park and the seasonal resort facilities 
are highly urbanized; power boats are permitted on certain lakes and skiing 
facilities have been developed. There are some cottage developments inside 
the park. Sport fishing is permitted. The vegetation has been altered by 
past grazing and logging, now discontinued. Intensive agricultural 
development of surrounding lands causes pressure on the wildlife 
populations of the park. 
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PRINCIPAL REFERENCE MATERIAL 
Briscoe, B.W., Lee, B.S., Allan, C. and Tempany, I. (1979). Riding 

Mountain National Park Resource Description and Analysis. 
Unpublished report, Parks Canada, Winnipeg. 264pp. 

Lombard North Group Ltd. (1976). Riding Mountain National Park, 
Biophysical Land Inventory. 

Oleson, R. and Wilmot, L. (1971). Bibliography of Riding Mountain National 
Park. 

Parks Canada (1977). A Master Plan for Riding Mountain National Park. 
Parks Canada (1980). Riding Mountain National Park Conservation Plan. 
Parks Canada (1984). Riding Mountain National Park Resource Description 

and Analysis. 

DATE Revised August 1986 
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Foreign Language Characters 

The following table lists foreign language characters that may be found in the database. 
You may enter these characters when doing a search by holding down the Alt key and 
entering the decimal code on the numeric keypad. 

Char 

C 
ü 
é 
â 
ä 
à 
â 
Ç 
ê 
ë 
è 

Code 

128 
129 
130 
131 
132 
133 
134 
135 
136 
137 
138 

Char 

ï 
î 
1 

Ä 
À 
É 
se 
JE 
ô 
ö 
Ö 

Code 

139 
140 
141 
142 
143 
144 
145 
146 
147 
148 
149 

Char 

A 

U 
U 

y 
ö 
ü 
á 
* 
i ó 
U 

ñ 
Ñ 

Code 

150 
151 
152 
153 
154 
160 
161 
162 
163 
164 
165 
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